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Objectives
In this lesson, you gain an understanding of the relational database management system (RDBMS) 
and the object relational database management system (ORDBMS). You are also introduced to 
Oracle SQL Developer and SQL*Plus as development environments used for executing SQL 
statements, and for formatting and reporting purposes.
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Course Objectives
This course offers you an introduction to Oracle Database 11g database technology. In this class, you 
learn the basic concepts of relational databases and the powerful SQL programming language. This 
course provides the essential SQL skills that enable you to write queries against single and multiple 
tables, manipulate data in tables, create database objects, and query metadata. 
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Oracle Database 11g: Focus Areas
Oracle Database 11g offers extensive features across the following focus areas:

• Infrastructure Grids: The Infrastructure Grid technology of Oracle enables pooling of low-cost 
servers and storage to form systems that deliver the highest quality of service in terms of 
manageability, high availability, and performance. Oracle Database 11g consolidates and 
extends the benefits of grid computing. Apart from taking full advantage of grid computing, 
Oracle Database 11g has unique change assurance features to manage changes in a controlled 
and cost effective manner.

• Information Management: Oracle Database 11g extends the existing information management 
capabilities in content management, information integration, and information life cycle 
management areas. Oracle provides content management of advanced data types such as 
Extensible Markup Language (XML), text, spatial, multimedia, medical imaging, and semantic 
technologies. 

• Application Development: Oracle Database 11g has capabilities to use and manage all the 
major application development environments such as PL/SQL, Java/JDBC, .NET and Windows, 
PHP, SQL Developer, and Application Express.
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Oracle Database 11g
Organizations need to support multiple terabytes of information for users who demand fast and 
secure access to business applications round-the-clock. The database systems must be reliable and 
must be able to recover quickly in the event of any kind of failure. Oracle Database 11g is designed 
along the following feature areas to help organizations manage infrastructure grids easily and deliver 
high-quality service:

• Manageability: By using some of the change assurance, management automation, and fault 
diagnostics features, the database administrators (DBAs) can increase their productivity, reduce 
costs, minimize errors, and maximize quality of service. Some of the useful features that 
promote better management are Database Replay facility, the SQL Performance Analyzer, and 
the Automatic SQL Tuning facility.

• High availability: By using the high availability features, you can reduce the risk of down time 
and data loss. These features improves online operations and enable faster database upgrades.
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Oracle Database 11g (continued)
• Performance: By using capabilities such as SecureFiles, compression for online transaction 

processing (OLTP), Real Application Clusters (RAC) optimizations, Result Caches and so on, 
you can greatly improve the performance of your database. Oracle Database 11g enables 
organizations to manage large, scalable transactional and data warehousing systems that deliver 
fast data access using low-cost modular storage.

• Security: Oracle Database 11g helps organizations protect their information with unique secure 
configurations, data encryption and masking, and sophisticated auditing capabilities. It delivers a 
secure and scalable platform for reliable and fast access to all types of information by using the 
industry-standard interfaces.

• Information integration: Oracle Database 11g has many features to better integrate data 
throughout the enterprise. It also supports advanced information life cycle management 
capabilities. This helps you manage the changing data in your database.



Oracle Database 11g: SQL Fundamentals I   I - 12

Oracle Fusion Middleware
Oracle Fusion Middleware is a comprehensive and well-integrated family of products that offers 
complete support for development, deployment, and management of Service-Oriented Architecture 
(SOA). SOA facilitates the development of modular business services that can be easily integrated 
and reused, thereby reducing development and maintenance costs, and providing higher quality of 
services. Oracle Fusion Middleware’s pluggable architecture enables you to leverage your 
investments in any existing application, system, or technology. Its unbreakable core technology 
minimizes the disruption caused by planned or unplanned outages.
Some of the products from the Oracle Fusion Middleware family include:

• Enterprise Application Server: Application Server
• Integration and Process Management: BPEL Process Manager, Oracle Business Process 

Analysis Suite
• Development Tools: Oracle Application Development Framework, JDeveloper, SOA Suite
• Business Intelligence: Oracle Business Activity Monitoring, Oracle Data Integrator
• Systems Management: Enterprise Manager
• Identity Management: Oracle Identity Management
• Content Management: Oracle Content Database Suite
• User Interaction: Portal, WebCenter
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Oracle Enterprise Manager Grid Control 10g 
Spanning applications, middleware, and database management, Oracle Enterprise Manager Grid 
Control 10g delivers integrated enterprise management for Oracle and non-Oracle systems. 
Oracle Enterprise Manager Grid Control 10g features advanced Oracle Fusion Middleware 
management capabilities for the services that business applications rely upon, including SOA, 
Business Activity Monitoring, and Identity Management. 

• Wide-ranging management functionality for your applications including service-level 
management, application performance management, configuration management, and change 
automation

• Built-in grid automation capabilities means that information technology responds proactively 
to fluctuating demand and implements new services more quickly so that businesses can thrive.

• In-depth diagnostics and readily available remediation across a range of applications 
including custom-built applications, Oracle E-Business Suite, PeopleSoft, Siebel, Oracle Fusion 
Middleware, Oracle Database, and underlying infrastructure 

• Extensive life cycle management capabilities extends grid computing by providing solutions 
for the entire application and infrastructure life cycle, including test, stage, and production 
through operations. It has simplified patch management with synchronized patching, additional 
operating system support, and conflict detection features.
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Oracle BI Publisher
Oracle Database 11g also includes Oracle BI Publisher—the enterprise reporting solution from 
Oracle. Oracle BI Publisher (formerly known as XML Publisher) offers the most efficient and 
scalable reporting solution available for complex, distributed environments. 
Oracle BI Publisher reduces the high costs associated with the development, customization, and 
maintenance of business documents, while increasing the efficiency of reports management. By 
using a set of familiar desktop tools, users can create and maintain their own report formats based on 
data queries created by the IT staff or developers. 
Oracle BI Publisher report formats can be designed using Microsoft Word or Adobe Acrobat—tools 
that most users are already familiar with. Oracle BI Publisher also enables you to bring in data from 
multiple data sources into a single output document. You can deliver reports via printer, email, or fax. 
You can publish your report to a portal. You can even allow users to collaboratively edit and manage 
reports on the Web-based Distributed Authoring and Versioning (WebDav) Web servers.
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Relational and Object Relational Database Management Systems
The Oracle server supports both the relational and the object relational database models.
The Oracle server extends the data-modeling capabilities to support an object relational database 
model that provides object-oriented programming, complex data types, complex business objects, 
and full compatibility with the relational world.
It includes several features for improved performance and functionality of the OLTP applications, 
such as better sharing of run-time data structures, larger buffer caches, and deferrable constraints. 
Data warehouse applications benefit from enhancements such as parallel execution of insert, update, 
and delete operations; partitioning; and parallel-aware query optimization. Operating within the 
Network Computing Architecture (NCA) framework, the Oracle model supports client/server and 
Web-based applications that are distributed and multitiered.
For more information about the relational and object relational model, see the Oracle Database 
Concepts 11g Release 1 (11.1) manual.
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Data Storage on Different Media
Every organization has some information needs. A library keeps a list of members, books, due dates, 
and fines. A company needs to save information about its employees, departments, and salaries. 
These pieces of information are called data.
Organizations can store data in various media and in different formats, such as a hard copy document 
in a filing cabinet, or data stored in electronic spreadsheets, or in databases.
A database is an organized collection of information.
To manage databases, you need a database management system (DBMS). A DBMS is a program that 
stores, retrieves, and modifies data in databases on request. There are four main types of databases: 
hierarchical, network, relational, and (most recently) object relational.
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Relational Database Concept
The principles of the relational model were first outlined by Dr. E. F. Codd in a June 1970 paper 
titled “A Relational Model of Data for Large Shared Data Banks.” In this paper, Dr. Codd proposed 
the relational model for database systems.
The common models used at that time were hierarchical and network, or even simple flat-file data 
structures. Relational database management systems (RDBMS) soon became very popular, especially 
for their ease of use and flexibility in structure. In addition, a number of innovative vendors, such as 
Oracle, supplemented the RDBMS with a suite of powerful, application development and user-
interface products, thereby providing a total solution.
Components of the Relational Model

• Collections of objects or relations that store the data
• A set of operators that can act on the relations to produce other relations
• Data integrity for accuracy and consistency

For more information, see An Introduction to Database Systems, Eighth Edition (Addison-Wesley: 
2004), written by Chris Date.
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Definition of a Relational Database
A relational database uses relations or two-dimensional tables to store information.
For example, you might want to store information about all the employees in your company. In a 
relational database, you create several tables to store different pieces of information about your 
employees, such as an employee table, a department table, and a salary table.
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Data Models
Models are the cornerstone of design. Engineers build a model of a car to work out any details before 
putting it into production. In the same manner, system designers develop models to explore ideas and 
improve the understanding of database design.
Purpose of Models
Models help communicate the concepts that are in people’s minds. They can be used to do the 
following:

• Communicate
• Categorize
• Describe
• Specify
• Investigate
• Evolve
• Analyze
• Imitate

The objective is to produce a model that fits a multitude of these uses, can be understood by an end 
user, and contains sufficient detail for a developer to build a database system.
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Entity Relationship Model
In an effective system, data is divided into discrete categories or entities. An entity relationship (ER) 
model is an illustration of the various entities in a business and the relationships among them. An ER 
model is derived from business specifications or narratives and built during the analysis phase of the 
system development life cycle. ER models separate the information required by a business from the 
activities performed within the business. Although businesses can change their activities, the type of 
information tends to remain constant. Therefore, the data structures also tend to be constant.
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Entity Relationship  Model (continued)
Benefits of ER Modeling:

• Documents information for the organization in a clear, precise format
• Provides a clear picture of the scope of the information requirement
• Provides an easily understood pictorial map for database design
• Offers an effective framework for integrating multiple applications

Key Components
• Entity: An aspect of significance about which information must be known. Examples are 

departments, employees, and orders.
• Attribute: Something that describes or qualifies an entity. For example, for the employee entity, 

the attributes would be the employee number, name, job title, hire date, department number, and 
so on. Each of the attributes is either required or optional. This state is called optionality. 

• Relationship: A named association between entities showing optionality and degree. Examples 
are employees and departments, and orders and items
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ER Modeling Conventions
Entities
To represent an entity in a model, use the following conventions:

• Singular, unique entity name
• Entity name in uppercase
• Soft box
• Optional synonym names in uppercase within parentheses: ( )

Attributes
To represent an attribute in a model, use the following conventions:

• Singular name in lowercase
• Asterisk (*) tag for mandatory attributes (that is, values that must be known)
• Letter “o” tag for optional attributes (that is, values that may be known)

Relationships
Symbol Description 
Dashed line Optional element indicating “maybe” 
Solid line Mandatory element indicating “must be” 
Crow’s foot Degree element indicating “one or more” 
Single line Degree element indicating “one and only one” 
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ER Modeling Conventions (continued)
Relationships
Each direction of the relationship contains:

• A label: for example, taught by or assigned to
• An optionality: either must be or maybe
• A degree: either one and only one or one or more

Note: The term cardinality is a synonym for the term degree.
Each source entity {may be | must be} in relation {one and only one | one or more} with the 
destination entity.
Note: The convention is to read clockwise.
Unique Identifiers
A unique identifier (UID) is any combination of attributes or relationships, or both, that serves to 
distinguish occurrences of an entity. Each entity occurrence must be uniquely identifiable.

• Tag each attribute that is part of the UID with a hash sign (#). 
• Tag secondary UIDs with a hash sign in parentheses (#).
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Relating Multiple Tables
Each table contains data that describes exactly one entity. For example, the EMPLOYEES table 
contains information about employees. Categories of data are listed across the top of each table, and 
individual cases are listed below. By using a table format, you can readily visualize, understand, and 
use information.
Because data about different entities is stored in different tables, you may need to combine two or 
more tables to answer a particular question. For example, you may want to know the location of the 
department where an employee works. In this scenario, you need information from the EMPLOYEES
table (which contains data about employees) and the DEPARTMENTS table (which contains 
information about departments). With an RDBMS, you can relate the data in one table to the data in 
another by using the foreign keys. A foreign key is a column (or a set of columns) that refers to a 
primary key in the same table or another table.
You can use the ability to relate data in one table to data in another to organize information in 
separate, manageable units. Employee data can be kept logically distinct from the department data by 
storing it in a separate table.
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Relating Multiple Tables (continued)
Guidelines for Primary Keys and Foreign Keys

• You cannot use duplicate values in a primary key.
• Primary keys generally cannot be changed.
• Foreign keys are based on data values and are purely logical (not physical) pointers.
• A foreign key value must match an existing primary key value or unique key value, otherwise it 

must be null.
• A foreign key must reference either a primary key or a unique key column.
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Relational Database Terminology
A relational database can contain one or many tables. A table is the basic storage structure of an 
RDBMS. A table holds all the data necessary about something in the real world, such as employees, 
invoices, or customers.
The slide shows the contents of the EMPLOYEES table or relation. The numbers indicate the 
following:

1. A single row (or tuple) representing all the data required for a particular employee. Each row in 
a table should be identified by a primary key, which permits no duplicate rows. The order of 
rows is insignificant; specify the row order when the data is retrieved.

2. A column or attribute containing the employee number. The employee number identifies a 
unique employee in the EMPLOYEES table. In this example, the employee number column is 
designated as the primary key. A primary key must contain a value and the value must be 
unique.

3. A column that is not a key value. A column represents one kind of data in a table; in this 
example, the data is the salaries of all the employees. Column order is insignificant when storing 
data; specify the column order when the data is retrieved.
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Relational Database Terminology (continued)
4. A column containing the department number, which is also a foreign key. A foreign key is a 

column that defines how tables relate to each other. A foreign key refers to a primary key or a 
unique key in the same table or in another table. In the example, DEPARTMENT_ID uniquely 
identifies a department in the DEPARTMENTS table.

5. A field can be found at the intersection of a row and a column. There can be only one value in it.
6. A field may have no value in it. This is called a null value. In the EMPLOYEES table, only those 

employees who have the role of sales representative have a value in the COMMISSION_PCT
(commission) field.
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Using SQL to Query Your Database
In a relational database, you do not specify the access route to the tables, and you do not need to 
know how the data is arranged physically.
To access the database, you execute a structured query language (SQL) statement, which is the 
American National Standards Institute (ANSI) standard language for operating relational databases. 
SQL is a set of statements with which all programs and users access data in an Oracle database. 
Application programs and Oracle tools often allow users access to the database without using SQL 
directly, but these applications, in turn, must use SQL when executing the user’s request. 
SQL provides statements for a variety of tasks, including:

• Querying data
• Inserting, updating, and deleting rows in a table
• Creating, replacing, altering, and dropping objects
• Controlling access to the database and its objects
• Guaranteeing database consistency and integrity

SQL unifies all of the preceding tasks in one consistent language and enables you to work with data 
at a logical level.
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SQL Statements
SQL statements supported by Oracle comply with industry standards. Oracle Corporation ensures 
future compliance with evolving standards by actively involving key personnel in SQL standards 
committees. The industry-accepted committees are ANSI and International Standards Organization 
(ISO). Both ANSI and ISO have accepted SQL as the standard language for relational databases.

Statement Description 
SELECT 
INSERT 
UPDATE 
DELETE 
MERGE 

Retrieves data from the database, enters new rows, changes existing rows, and 
removes unwanted rows from tables in the database, respectively. Collectively 
known as data manipulation language (DML)  

CREATE 
ALTER 
DROP 
RENAME 
TRUNCATE 
COMMENT 

Sets up, changes, and removes data structures from tables. Collectively known as 
data definition language (DDL) 

GRANT 
REVOKE 

Provides or removes access rights to both the Oracle database and the structures 
within it  

COMMIT 
ROLLBACK 
SAVEPOINT 

Manages the changes made by DML statements. Changes to the data can be 
grouped together into logical transactions 
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Development Environments for SQL
This course has been developed using Oracle SQL Developer as the tool for running the SQL 
statements discussed in the examples in the slide and the practices. For commands that are not 
supported by Oracle SQL Developer, use the SQL*Plus environment. 
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What Is Oracle SQL Developer?
Oracle SQL Developer is a free graphical tool designed to improve your productivity and simplify 
the development of everyday database tasks. With just a few clicks, you can easily create and debug 
stored procedures, test SQL statements, and view optimizer plans.
Oracle SQL Developer, the visual tool for database development, simplifies the following tasks:

• Browsing and managing database objects
• Executing SQL statements and scripts
• Editing and debugging PL/SQL statements
• Creating reports

You can connect to any target Oracle database schema by using the standard Oracle database 
authentication. When connected, you can perform operations on objects in the database.
Note: The Oracle SQL Developer, Release 1.2 is called the Migration release because it tightly 
integrates with Developer Migration Workbench. Therefore, it provides users with a single point to 
browse database objects and data in third-party databases, and to migrate from these databases to 
Oracle. You can also connect to schemas for selected third-party (non-Oracle) databases, such as 
MySQL, Microsoft SQL Server, and Microsoft Access, and view metadata and data in these 
databases.
Additionally, Oracle SQL Developer, Release 1.2 includes support for Oracle Application Express, 
Release 3.0.1 (Oracle APEX).
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Specifications of Oracle SQL Developer
Oracle SQL Developer is developed in Java leveraging the Oracle JDeveloper integrated 
development environment (IDE). It is a cross-platform tool. The tool runs on Windows, Linux, and 
Mac operating system (OS) X platforms. You can install Oracle SQL Developer on the database 
server and connect remotely from your desktop, thus avoiding client/server network traffic.
Default connectivity to the database is through the Java Database Connectivity (JDBC) Thin driver, 
so Oracle Home is not required. Oracle SQL Developer does not require an installer and you need to 
simply unzip the downloaded file. With Oracle SQL Developer, users can connect to the Oracle 
Database, version 9.2.0.1 and later, and all Oracle database editions including the Express Edition. 
Oracle SQL Developer can be downloaded with the following packaging options:

• Oracle SQL Developer for Windows (option to download with or without Java Development 
Kit (JDK) 1.5)

• Oracle SQL Developer for Multiple Platforms (you should have JDK 1.5 already installed)
• Oracle SQL Developer for Mac OS X platforms (you should have JDK 1.5 already installed)
• Oracle SQL Developer RPM for Linux (you should have JDK 1.5 already installed)

Note that Oracle SQL Developer, Release 1.2 is also certified with JDK 6.0.
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Oracle SQL Developer Interface
Oracle SQL Developer has two main navigation tabs:

• Connections tab: By using this tab, you can browse database objects and users to which you 
have access.

• Reports tab: By using this tab, you can run predefined reports, or create and add your own 
reports.

Oracle SQL Developer uses the left pane for navigation to find and select objects, and the right pane 
to display information about selected objects. You can customize many aspects of the appearance and 
behavior of Oracle SQL Developer by setting preferences. The menus at the top contain standard 
entries, plus entries for features specific to Oracle SQL Developer.

1. View: Contains options that affect what is displayed in the Oracle SQL Developer interface
2. Navigate: Contains options for navigating to panes and in the execution of subprograms
3. Run: Contains the Run File and Execution Profile options that are relevant when a function or 

procedure is selected
4. Debug: Contains options relevant when a function or procedure is selected for debugging
5. Source: Contains options for use when editing functions and procedures
6. Migration: Contains options related to migrating third-party databases to Oracle
7. Tools: Invokes tools such as SQL*Plus, Preferences, and SQL Worksheet

Note: You must define at least one connection to be able to connect to a database schema and issue 
SQL queries or run procedures/functions.
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Creating a Database Connection
A connection is an Oracle SQL Developer object that specifies the necessary information for 
connecting to a specific database as a specific user of that database. To use Oracle SQL Developer, 
you must have at least one database connection, which may be existing, created, or imported.
You can create and test connections for multiple databases and for multiple schemas.
By default, the tnsnames.ora file is located in the $ORACLE_HOME/network/admin 
directory. But, it can also be in the directory specified by the TNS_ADMIN environment variable or 
the registry value. When you start Oracle SQL Developer and display the Database Connections 
dialog box, Oracle SQL Developer automatically imports any connections defined in the 
tnsnames.ora file on your system.
Note: On Windows systems, if the tnsnames.ora file exists but Oracle SQL Developer is not 
using its connections, define TNS_ADMIN as a system environment variable.
You can export connections to an XML file so that you can reuse it later.
You can create additional connections as different users to the same database or to connect to the 
different databases.
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Creating a Database Connection (continued)
To create a database connection, perform the following steps:

1. On the Connections tabbed page, right-click Connections and select New Connection.
2. In the New/Select Database Connection window, enter the connection name. Enter the username 

and password of the schema that you want to connect to.
1. From the Role drop-down list, you can select either default or SYSDBA (you will select 

SYSDBA for the sys user or any user with DBA privileges). 
2. You can select the connection type as:

- Basic: In this type, you enter the host name and system identifier (SID) for the database 
that you want to connect to. The Port is already set to 1521. Or, you can also enter the 
Service name directly if you are using a remote database connection.

- TNS: You select any one of the database aliases imported from the tnsnames.ora
file

- Advanced: You define a custom JDBC URL to connect to the database.
3. Click Test to make sure that the connection has been set correctly.
4. Click Connect.

If you select the Save Password check box, the password is saved to an XML file. So, after you close 
the Oracle SQL Developer connection and open it again, you will not be prompted for the password.
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Creating a Database Connection (continued)
3. The connection gets added in the Connections Navigator. You can expand the connection to 

view the database objects and view object definitions, for example, dependencies, details, 
statistics, and so on.

Note: From the same New/Select Database Connection window, you can define connections to non-
Oracle data sources by using the Access, MySQL, and SQL Server tabs. However, these connections 
are read-only connections that enable you to browse objects and data in that data source.
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Browsing Database Objects
After you have created a database connection, you can use the Connections Navigator to browse 
through many objects in a database schema including Tables, Views, Indexes, Packages, Procedures, 
Triggers, Types, and so on.
Oracle SQL Developer uses the left pane for navigation to find and select objects and the right pane 
to display information about the selected objects. You can customize many aspects of the appearance 
of Oracle SQL Developer by setting preferences.
You can see the definition of the objects broken into tabs of information that is pulled out of the data 
dictionary. For example, if you select a table in the Navigator, the details about columns, constraints, 
grants, statistics, triggers, and so on are displayed in an easy-to-read tabbed page.
If you want to see the definition of the EMPLOYEES table as shown in the slide, perform the 
following steps:

1. Expand the Connections node in the Connections Navigator. 
2. Expand Tables.
3. Click EMPLOYEES. By default, the Columns tab is selected. It shows the column description of 

the table. By using the Data tab, you can view the tables data and also enter new rows, update 
data, and commit these changes to the database.
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Using the SQL Worksheet
When you connect to a database, a SQL Worksheet window for that connection is automatically 
opened. You can use the SQL Worksheet to enter and execute SQL, PL/SQL, and SQL*Plus 
statements. All SQL and PL/SQL commands are supported as they are passed directly from the SQL 
Worksheet to the Oracle database. However, the SQL*Plus commands used in Oracle SQL Developer 
have to be interpreted by the SQL Worksheet before being passed to the database. 
The SQL Worksheet currently supports a number of SQL*Plus commands. Those commands that are 
not supported by the SQL Worksheet are ignored and not sent to the Oracle database. Through the 
SQL Worksheet, you can execute SQL statements and some of the SQL*Plus commands.
You can display a SQL Worksheet by using any of the following two options:

• Select Tools > SQL Worksheet.
• Click the Open SQL Worksheet icon available on the main toolbar.
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Using the SQL Worksheet (continued)
You may want to use shortcut keys or icons to perform certain tasks, such as executing a SQL 
statement, running a script, or viewing the history of the SQL statements that you have executed. 
You can use the SQL Worksheet toolbar that contains icons to perform the following tasks:

1. Execute Statement: This executes the statement at the cursor in the Enter SQL Statement box. 
Alternatively, you can press [F9]. The output is generally shown in a formatted manner in the 
Results tab page.

2. Run Script: This executes all statements in the Enter SQL Statement box using the Script 
Runner. The output is generally shown in the conventional script format in the Scripts tab page. 

3. Commit: This writes any changes to the database and ends the transaction.
4. Rollback: This discards any changes to the database, without writing them to the database, and 

ends the transaction.
5. Cancel: This stops the execution of any statements currently being executed.
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Using the SQL Worksheet (continued)
6. SQL History: This displays a dialog box with information about the SQL statements that 

you have executed.
7. Execute Explain Plan: This generates the execution plan, which you can see by clicking 

the Explain tab.
8. Autotrace: This displays trace-related information when you execute the SQL statement 

by clicking the Autotrace icon. This information can help you to identify the SQL 
statements that will benefit from tuning.

9. Clear: This erases the statement or statements in the Enter SQL Statement box. 
Alternatively, press and hold [Ctrl] + [D] to erase the statements.
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Executing SQL Statements
In the SQL Worksheet, you can use the Enter SQL Statement box to enter a single or multiple SQL 
statements. For a single statement, the semicolon at the end is optional.
When you enter the statement, the SQL keywords are automatically highlighted. To execute a SQL 
statement, ensure that your cursor is within the statement and click the Execute Statement icon. 
Alternatively, you can press [F9].
To execute multiple SQL statements and see the results, click the Run Script icon. Alternatively, you 
can press [F5].
The example in the slide shows the difference in output for the same query when F9 key or Execute 
Statement is used versus the output when F5 or Run Script is used.
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Formatting the SQL Code
You may want to beautify the indentation, spacing, capitalization, and the line separation of the SQL 
code. Oracle SQL Developer has the feature for formatting the SQL code.
To format the SQL code, right-click in the statement area, and select Format SQL.
In the example in the slide, before formatting, the keywords are not capitalized and the statement is 
not properly indented in the SQL code. After formatting, the SQL code is beautified with the 
keywords capitalized and the statement properly indented.
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Saving SQL Statements 
In most of the practices that you will perform, you will need to save a particular query in the SQL 
Worksheet as a .sql file. To do so, perform the following:

1. From the File menu, select Save or Save As (if you are renaming a current .sql script) or you 
can right-click the SQL Worksheet and select Save File. Alternatively, you can press and hold 
[CTRL] + [S].

2. In the Save dialog box, enter the appropriate filename. Make sure the extension is .sql or the 
File type is selected as SQL Script (*.sql). Click Save.
Note: For this course, you need to save your sql scripts in the D:\labs\sql1\labs folder.

3. The SQL Worksheet is renamed to the filename that you saved the script as. Make sure you do 
not enter any other SQL statements in the same worksheet. To continue with other SQL queries, 
open a new worksheet.
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Running Script Files
To run the saved .sql script files, perform the following:

1. Right-click the SQL Worksheet and select Open File, or select Open from the File menu. 
Alternatively, you can press and hold [CTRL] + [O].

2. In the Open dialog box, move to the D:\labs\sql\labs folder, or to the location in which 
you saved the script file, select the file and click Open.

3. The script file opens in a new worksheet. Now, you can run the script by either clicking the 
Execute Statement icon or the Run Script icon. Again, make sure you do not enter any other 
SQL statements in the same worksheet. To continue with other SQL queries, open a new 
worksheet.
Note: You may want to set the default directory to D:\labs\sql1 folder, so that every time 
you try to open or save a script, SQL Developer chooses the same path to look for scripts. From 
Tools menu, select Preferences. In the Preferences dialog box, expand Database and select 
Worksheet Parameters. In the right pane, click Browse to set the default path to look for scripts 
and click OK.

Note: For more details on how to use the Oracle SQL Developer GUI interface for other data objects 
creation and data retrieval tasks, refer to Appendix G “Performing DML and DDL Operations Using 
the Oracle SQL Developer GUI.”
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Starting SQL*Plus from Oracle SQL Developer
The SQL Worksheet supports most of the SQL*Plus statements. SQL*Plus statements must be 
interpreted by the SQL Worksheet before being passed to the database; any SQL*Plus statements that 
are not supported by the SQL Worksheet are ignored and not passed to the database. To display the 
SQL*Plus command window, from the Tools menu, select SQL*Plus. To use this feature, the system 
on which you are using Oracle SQL Developer must have an Oracle Home directory or folder, with a 
SQL*Plus executable in that location. If the location of the SQL*Plus executable is not already 
stored in your Oracle SQL Developer preferences, you are asked to specify its location.
Note: If the Tools > SQL*Plus menu option is disabled, click the database connection, such as 
myconnection, in the Connections Navigator. The menu option is disabled if any SQL Worksheet is 
active.
For example, some of the SQL*Plus statements that are not supported by SQL Worksheet are:
• append
• archive
• attribute
• break

For a complete list of the SQL*Plus statements that are supported and not supported by the SQL 
Worksheet, refer to the SQL*Plus Statements Supported and Not Supported in SQL Worksheet topic 
in the Oracle SQL Developer online Help.
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SQL Statements in SQL*Plus
Oracle SQL*Plus is a command-line interface with which you can submit SQL statements and 
PL/SQL blocks for execution and receive the results in an application or command window.
SQL*Plus is:

• Shipped with the database
• Installed on a client and on the database server system
• Accessed through from an icon or the command line

Note: If you do not have access to Oracle SQL Developer and would prefer to use SQL* Plus, the 
classroom setup provides SQL*Plus icon on your desktop. It may also be useful to use it in cases 
where Oracle SQL Developer does not support any SQL* Plus command.
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The Human Resources (HR)Schema Description
The Human Resources (HR) schema is a part of the Oracle Sample Schemas that can be installed in 
an Oracle database. The practice sessions in this course use data from the HR schema.
Table Descriptions
• REGIONS contains rows that represent a region such as America, Asia, and so on.
• COUNTRIES contains rows for countries, each of which is associated with a region.
• LOCATIONS contains the specific address of a specific office, warehouse, or production site of 

a company in a particular country. 
• DEPARTMENTS shows details about the departments in which the employees work. Each 

department may have a relationship representing the department manager in the EMPLOYEES
table.

• EMPLOYEES contains details about each employee working for a department. Some employees 
may not be assigned to any department.

• JOBS contains the job types that can be held by each employee.
• JOB_HISTORY contains the job history of the employees. If an employee changes departments 

within a job or changes jobs within a department, then a new row is inserted into this table with 
the earlier job information of the employee.
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Tables Used in the Course
The following main tables are used in this course:
• EMPLOYEES table: Gives details of all the employees
• DEPARTMENTS table: Gives details of all the departments
• JOB_GRADES table: Gives details of salaries for various grades

Apart from these tables, you will also use the other tables listed in the previous slide such as the 
LOCATIONS and the JOB_HISTORY table.
Note: The structure and data for all the tables are provided in Appendix B.
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Oracle Database 11g Documentation
Navigate to http://www.oracle.com/pls/db111/homepage to access the Oracle Database 11g
documentation library.

http://www.oracle.com/pls/db111/homepage
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Summary
Relational database management systems are composed of objects or relations. They are managed by 
operations and governed by data integrity constraints.
Oracle Corporation produces products and services to meet your RDBMS needs. The main products 
are the following:

• Oracle Database 11g with which you store and manage information by using SQL
• Oracle Fusion Middleware with which you develop, deploy, and manage modular business 

services that can be integrated and reused
• Oracle Enterprise Manager Grid Control 10g, which you use to manage and automate 

administrative tasks across sets of systems in a grid environment
SQL
The Oracle server supports ANSI-standard SQL and contains extensions. SQL is the language that is 
used to communicate with the server to access, manipulate, and control data.
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Practice I: Overview
In this practice, you perform the following:

• Run through the Oracle SQL Developer demo.
• Use Oracle SQL Developer to examine data objects in the ORA account assigned to you. The 
ORA accounts contain the HR schema tables. 

Note the following location for the lab files:
D:\labs\SQL1\labs

If you are asked to save any lab files, save them in this location.
In any practice, there maybe exercises that are prefaced with the phrases “If you have time” or “If 
you want an extra challenge.” Work on these exercises only if you have completed all other exercises 
within the allocated time and would like a further challenge to your skills.
Perform the practices slowly and precisely. You can experiment with saving and running command 
files. If you have any questions at any time, ask your instructor.
Note: All written practices use Oracle SQL Developer as the development environment. Although it 
is recommended that you use Oracle SQL Developer, you can also use SQL*Plus that is available in 
this course.
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Practice I
This is the first of many practices in this course. The solutions (if you require them) can be found in 
Appendix A. Practices are intended to cover most of the topics that are presented in the 
corresponding lesson.
Run Through the Oracle SQL Developer Demo: Creating a Database Connection

1. Access the demo“Creating a database connection” at:
http://st-curriculum.oracle.com/tutorial/SQLDeveloper/html/module2/mod02_cp_newdbconn.htm

Starting Oracle SQL Developer
2. Start Oracle SQL Developer using the sqldeveloper desktop icon.  

Note: When you start SQL Developer for the first time, you need to provide the path to the 
java.exe file. This is already done for you as a part of the classroom setup. In any case, if 
you are prompted, enter the following path:
D:\app\Administrator\product\11.1.0\client_1\jdevstudio\jdk\bin

Creating a New Oracle SQL Developer Database Connection
3. To create a new database connection, in the Connections Navigator, right-click Connections. 

Select New Connection from the menu. The New/Select Database Connection dialog box 
appears.

4. Create a database connection using the following information:
a. Connection Name: myconnection.
b. Username: oraxx where xx is the number of your PC (Ask your instructor to assign you 

one ora account out of the ora1-ora20 range of accounts.).
c. Password: oraxx
d. Hostname: Enter the host name of the machine where your database server is running.
e. Port: 1521
f. SID: ORCL
g. Ensure you select the Save Password check box.

http://st-curriculum.oracle.com/tutorial/SQLDeveloper/html/module2/mod02_cp_newdbconn.htm
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Practice I (continued)
Testing and Connecting Using the Oracle SQL Developer Database Connection 

5. Test the new connection. 
6. If the status is Success, connect to the database using this new connection.

Browsing the Tables in the Connections Navigator
7. In the Connections Navigator, view the objects available to you in the Tables node. Verify that 

the following tables are present:
COUNTRIES
DEPARTMENTS
EMPLOYEES
JOB_GRADES
JOB_HISTORY
JOBS
LOCATIONS
REGIONS

8. Browse the structure of the EMPLOYEES table.
9. View the data of the DEPARTMENTS table.

Opening a SQL Worksheet
10.Open a new SQL Worksheet. Examine the shortcut icons available for the SQL Worksheet.




